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Agenda

New empty project in the Quartus
Schematic editor

/O settings

Programming the device

Half adder

~ul adder

Adding of two bits number

NOoO Ok owdRE
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New empty project in the Quartus

oroject

Define name of the project
Project type — Empty project
Skip add files
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File -> New ->New Quartus Prime Project
Select working directory and name of the

¢

GNEW

e

——
MNew Cuartus Prime Projﬁ)

W

1"

S
AHDL File

Block Diagram/Schematic File
EDIF File

Gsys System File

State Machine File
SystemVerilog HDL File

Tel Script File

Werilog HDL File

WHDL File

¥ Memaory Files

Hexadecimal (Intel-Format) File

Memory Initialization File

* Verification/Debugging Files

In-System Sources and Probes File
Logic Analyzer Interface File

Signal Tap Logic Analvzer File

Cancel Help

i Mew Project Wizard

Directory, Name, Top-Level Entity 2

What is the working directory for this project?

| C:hintelF PGA_litE‘n,qculen‘n,week_D.2|

What is the name of this project?

|week_D.2

What is the name of the top-level design entity for this project? Thi
design file.

|week_02

Use Existing Project Settings...

i Mew Project Wizard

Project Type

3.

Select

O] Empty project

Create new project by specifying prgisefTiles and lib

() Project template

Create a project from an existing design template. i IVI
download design templates from the Design Store.
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New empty project in the Quartus

i Mew Project Wizard x
Il

Family, Device & Board Settings

— Select device from the
B Oard D E 1 _ SO C Or m an u aI |y Select the board/development kit you want to target for compilation.

Family: |Cyclone V ¥ | Development KN | DE1-SoC Board e
5CSEMA5F31C6
Narme Version Family Vendor ALMs Total I/Os

SCSEMASF31Ce Afera 32070 457

— Skip EDA Tool Settings B oersocomt [roJomtmy
— Finish

< >

Create top-level design file.

Can't find your board? Check the Design Store for additions and search for baseline under Design Examples.

< Back Einish Cancel Help
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New empty project in the Quartus

— Assignment -> Device -> Device and Pin Options
— Unused Pins -> As input tri-stated

G Device

Device Board

Select the family and device you want to target for compilation.

You can install additional device support with the Install Devices command on the Tools menu.

To determine the version of the Quartus Prime software in which your target device is supported, re

Device family
Family: | Cyclone V [EfGX/GT/SX/SE/ST)
Device: |All
Target device
Auto device selected by the Fitter
®) specific device selected in *Available devices' list
Other: nfa

Available devices:

Show in ‘Available devices'|
Package: Any
Fin count: Any

Core speed grade: | Any

MName filter:

(@ Device and Pin Options - week_02_02

Category:

General

Configuration

iil i Imming Files

Dual-Purpose Pins
Capacitive Loading
Board Trace Model
IfO Timing

Voltage

Pin Placement
Error Detection CRC

Show advanced devices

|Devicear1d Pin Options...
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Specify device-wide options for reserving all unused pins on the device. To reserve individual dual-purpose
configuration pins, go to the Dual-Purpose Pins tab. To reserve other pins individually, use the Assignment
Editor.

Reserve all unused pi As input tri-stated
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Schematic editor

— File -> New -> Block Diagram/Schematic File
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b New x

Mew Quartus Prime Project
* Design Files
ABM_Cil

( Block Diagram/Schematic File )

E

Osys System File
State Machine File
System\Verilog HDL File
Tcl Script File
Verilog HDL File
WHOL File

¥ Memory Files
Hexadecimal (Intel-Format) File
Mermary Initialization File

* Verification/Debugging Files
In-System Sources and Probes File

Logic Analyzer Interface File

Signal Tap Logic Analvzer File

Cancel Help
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Schematic editor

— We will need four basic gates
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Schematic editor

— We will use keys from the
board, which are in negative
logic. We need to invert it
for positive logic.
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VCC3P3

KEY0
KEY1 p—————p AA14
KEY1 =
—6 o e s [NETSRVA
KEY2 74HC245 | (pyo =~
. N > W15 (:Iﬂt=l¢g!15§EEf"
o
O O " KEY3
> Y16
KEY3
o
O O—e

Figure 3-14 Connections between the push-buttons and the Cyclone V SoC FPGA

MUNI
F 1



Schematic editor

-Place a symbol not - - -~ _

Block4. bdf
r @kﬁwﬂ‘A@“E'DTﬂ‘T\\\DCJ\“W-Q-—iﬁd-ﬂb.

................................. A

........................... A
i o Symbol

........................... Libraries:

--------------------------- V@u::fintelfpga_litefzD.‘l;’quartus)’liA

--------------------------- tlmegafunctions

--------------------------- 23 others

--------------------------- “"E‘primitives

N 23 buffer ST

--------------------------- VBlDEIE

--------------------------- ﬂ-andalz

........................... 1

MNAMmE: e e
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Schematic editor

3lock4. bdf* x|

—Place one input port and one output Q¥AOBRIOTITINNNDOON Y [@

port and connect it to the NOT gate.
—The name of the input port will KEY|O],
of the output LED[O].
—Save the schematic file.
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/O settings

— Assignment of keys from the DE1-SoC manual

Signal Name
KEY[0]
KEY[1]
KEY[2]
KEY[3]

Table 3-7 Pin Assignment of Push-buttons

FPGA Pin No.
PIN_AA14
PIN_AA15
PIN_W15
PIN_Y16
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Description

Push-button[0]
Push-button[1]
Push-button[2]
Push-button[3]

I/O Standard
3.3V
3.3V
3.3V
3.3V



/O settings

— Assignment of LEDS from the DE1-SoC manual

Table 3-8 Pin Assignment of LEDs

Sighal Name FPGA Pin No. Description I/O Standard
LEDR[0] PIN_V16 LED [0] 3.3V
LEDR[1] PIN_W16 LED [1] 3.3V
LEDR[2] PIN_V17 LED [2] 3.3V
LEDR[3] PIN_V18 LED [3] 3.3V
LEDR[4] PIN_W17 LED [4] 3.3V
LEDR[3] PIN_W19 LED [9] 3.3V
LEDR[6] PIN_Y19 LED [6] 3.3V
LEDR[7] PIN_W20 LED [7] 3.3V
LEDR][8] PIN_W21 LED [8] 3.3V
LEDR[9] PIN_Y21 LED [9] 3.3V
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/O settings

— Processing -> Start -> Start Analysis & Elaboration

LU FULETD_WUT By WEEK_US_ Uy WEEE_UE_ UL - WEEK_ UL _Us
na

Tasks Compilation A

nents | Processing  Tools Window Help

week_ Stop Processing Ctrl+Shift+C Q @ 2 & _.‘ L] v P Compile Design

¥ P Analysis & Synthesis

Task Time

P Start Compilation Cirl+L week_02_02.bdf
_ B Edit Settings
Entity: %/ Analyze Current File niid] BExhQWATE-0O017 7 View Report
Start r oo P Analysis & Elaboration 00:00:13

Start Hierarchy Elaboration

Update Memory Initialization File Start Analysis & Elaboration

b
Netlist Viewers
< Compilation Report Ctrl+R . .
Fi' Start AnalYSIS & SYchESIS Ctrl+K - Design Assistant (Post-Mapping)
@ Dynamic Synthesis Report %%  Start Partition Merge ¥ P /O Assignment Analysis
H Start Fitter ER View Report

Power Analyzer Tool

At
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/O settings

— Assignments -> Pin Planner

C:/Projects/Altera_work/week_02_02/week_02_02 - weel_02_02 Tasks

Assignments  Processing  Tools  Window  Help

v P Compile Design

ﬁ“ Device... b F
= Settings... Ctrl+Shift+E i a
Q: Assignment Editor Ctri+Shift+A

@ Pin Planner Ctrl+Shift+N

Remove Assignments..

=

~ P Analysis & Synthesis

P Analysis & Elaboration

P Partition Merge

P> Design Assistant (Post-Mapping)

v P oo Assignment Analysis

Back-Annotate Assignments... - =
- - - - - @

— Set the right parameters for our pins

Top View - Wire Bond
Cyclone V - 5CSEMAS5F31C6

pa—
& et e oo | St Somisi | cogin

.‘ 1 2 3 &4 5 [ T a8 3 "M 1" 12 13 14 15 %% 17 18 13 20 21 22 23 24 25 26 ¥ 28 23 30
[ NVOooRoARDOOOVORROVOROOVEROYVEE |+
: @OOAROOOVARDOVEOOBOVORBOVOEOGOVE
NOROVOORAROEEVEOOROVOR®OVOHERE
» @B Vi @ AGOBOVEOOOOAOOEOVOOYOADE
: @EEOAOROOVOOOOADODOABAGOY XOOEY
FxVQQVDV®@@@&@®®QV®@®@ HOVOOE) -
s WXNVNVEOOOAOQOOALOOOAREOOOHVOOASAR
’ X XN AR NN/ EOOAOOBOAGEOE)
\WaVi6 \/ OOOBOOVOE) -
« NN X XN AV A AVOOBEOA «
YAV 0.0.0). PEOOABOE .
WX XTI AATATA ADODOVE)
VAVAVAYZARYZ.NYAY OOVOOEE
» NV X XAV A EOOOADE) -
» NN AT AV AY OACOBOY -
VAV C YA elolelo\Violook
VAVAVAVZARY; X®®®®WAU
OAOEEE)] v
w i\ VO 000ADEOOYVEOE) v
+ N X XA ; OVOARRVIOEEV,
M VAVAYAY : OmMA, NOOTACLC» —
w2\ N X XN : AONTAVALD @OADDIE\/ @) ===
P VAVAVAV.OV.€ AARADAY ATADACBAOVOO R«

QO AR X ADADQONAVOR@@ADE@

MVAVAVAY. O 0l0¢
«NAA/OBEAD000VOMNHOVO0OOADROON D 6~
< OOCADODOVOOOOVOODOADODOVODOOAD

‘2!45E'f'S!‘G“‘2‘.!‘4‘5‘E"f"8‘!2}2‘222!2425252?2823!(}
—— ] (==
| | |
Mode Name Direction Location I/C Bank WREF Group I/ Standard Reserved Current Strength Slew Rate Diffi
- KEY[O] Input PIN_AAT4 3B 3.3-V LVCMOS 2mA (defauly)
‘e LED[O] Output PIN_V16 44 3.3-V LVCMOS 2mA (defaul) (0 !

<<new nodes>

14 PV200, Week 02: Combination logic - Schematic, basic gates

=
— =

PVDOOOADROOYAGOOADODOA x ===




Programming the device

— Compile the project
— Open the programmer
— Check connection to

the DE SoC board C:*““j;f“

— Select 5CSEMAS
— Detect your FPGA
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N

W start

Mo s

" Add File...

& Change File...

$ save File
® Add Device...
i Up

i Down

[ Enable reat-ume

—

o Hardware Setup... |DE-SoC [USB-1]

D)

Mode: | JTAG w7 Progress

w packground programming when available

<none>

File

SOCVHPS

Device

---------
.
:
TDI - =
—: b .
: .
:
---------
SCSEMASF31
. TDO

Checksum Usercode Program/  Verify  Blank- Examine
Configure Check

Q0000000 <none>

b Select Device

Found devices with shared JTAG ID for device 2. Please select your device.

ecuri

et

() 5CSEBAS

< ® 5CSEMAS )

(O 5CSTFDSDS
(0 5CSXFCSCE

O scsxFosDe




Programming the device

» Programmer - C:/intelFPGA_lite/qculen/week_02/week_02 - week_02 - [week_02.cdf]* — O *
F P G n 5 C S E M n 5 i File Edit View Processing Tools Window Help Search altera.com |e'
; Hardware Setup...| |DE-5oC [USBE-1] Mode: | JTAG = Progress: [ ]
d ete Cte d [ Enable real-time ISP to allow background programming when available
% gt File Device Checksum Usercode Program/  Verify  Blank- Examine  Security Erase ISP
"“' Configure Check Bit CLAMP
b stop <none> 00000000  <nones
wﬁ\utu Detect <none> 00000000 <none>
Delete
U add File...
a Change File...
& save File
* 4 dd Device. JECTITEITIS JETTTECITEN
§ o P ;
up - b H b H
H H H H
b pown TITIIII e T
SOCVHPS SCSEMAS
. TDO
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Programming the device

— Add file to the
5CSEMAS device
from the project
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N

o Hardware Setup... |DE—SDC [USE-1]

Mode:

JTAG

- Progress:
[ Enable real-time ISP to allow background programming when available
b giart » Select Programming File % Erase ISP
CLAMP
ti Stop <nones Lookin: CAintelFPGA_lite\gculen\week_02\output_files @ @ @ @ %]
# Auto Detect | | [*"O" B My computer [ week_02.s0f
Delete 3 Jirka
M Add File..
a Change File...
B save File
* Add Device...
b up TOI
A Down
TDC
—

File name:  |week_02.sof

| | Open

Files of type: | Programming Files (*.sof *.pof *_jam * jbc *.ekp * jic)

~ Cancel
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Programming the device

& Programmer - Ct/intelFPGA_lite/gculen/week_02/week_02 - week_02 - [week_02.cdf]* - O x

Eile Edit View Processing Tools Window Help

— Delete device 5CSEMAS ... oo =R

[ Enable real-time ISP to allow background programming when available

wh grart File Device Checksum Usercode Program/  Verify = Blank- Examine Security  Erase ISP
Configure Check Bit CLAMP
th Stop SOCVHPS 00000000 <none>
output_filesfweek_02.s.. 5CSEMASF31 DOAF1574 DOAF1574
X Delete
" addFile..
pe Change File...
B save File
.AddDE\fiCE... .---------. Ew..‘m._." .---------.
DI H H é H H H
- = - =
Thup —: P —bE i—i b :
- = u = H =
H H : H H H
[% Down SammamEEn r_l_l.l.llll.l.l._: TEmEmEmEn
SOCVHPS SCSEMAS SCSEMASF3T
TDO
4
4
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Programming the device

— Select 5CSEMA5F31
— Start the programming

— Test your application
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» Programmer - C:/intelFPGA_lite/qculen/week_02/week_02 - week_02 - [week_02.cdf]” — O *
File Edit View Processing Tools Window Help Search altera.com |e
; Hardware Setup... |DE-SoC [USE-1] Mode: |JTAG 7 Progress: 100% (Successful) I

[ Enable real-time ISP to allow background programming when available
Wb gt File Device Checksum Usercade Program/  Verify  Blank- Examine  Security Erase ISP |
Configure Check Bit CLAMP
1l Stop =nones SOCVHPS 00000000 <nonex
. v b
m e output_filesfweek 02.5.. SCSEMASF31 0O0AF1514  ODAF1514
X Delete
" pdd File
i Change File... < >
4 save File
* . 4d Device._ ETITITIT N [poresaicee)
L] - L] Cl
TDI H H E H
T up —: S d i :
L] - | -
H H i H
" pown TEEREEREEE Eluuujuu._l
SOCVHPS SCSEMASF3T
TDO

LS
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Half adder

— Add the next pair of KEY and LED.

— For loading new ports to the I/O planner, You need repeat start of
the Analysis & Elaboration

_ COmplle It and teSt It. KE[EIQE&T ruj>o L DLTFLT:LED[S]

...................................................................... =
KEYTH — J>O : QUTRUT ™ | Epp1]
ettt e R S ingf@ D e T
Mode Name Direction Location I/ Bank VREF Group Fitter Location I/ Standard Reserved Current Strength Slew Rate
B KEY[1] Input PIN_AA15 3B B3B_NO PIN_AATS 3.3-V LVCMOS 2mA (defaulf)
& KEY[O] Input PIN_AAT4 3B B3B_NO PIN_AA14 3.3-V LVCMOS 2maA (defauls)
‘s LED[1] Output PIN_W16 aA B4A_NO PIN_W16 3.3-V LVCMOS 2mA (default) ©
"5 LED[0] Output PIN V16 4A B4A_NO PIN V16 3.3-V LVCMOS 2mA (defaul) ©
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Half adder

— Create a new schematic file “half _adder”
— Use File -> Create/Update -> Create Symbol Files for Current File

A | B | SUM | CARRY o R
0 0 o A —— T S e
e - NI ) S i

R O +— O

0 1 0
1 1 0
1 0 1
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Half adder

— Put the half adder to the top schematic
— Compile it, program it, and test it...

RE 0] =1 J>O : | ) ;half adder . | ;DUTF'L'T > LeD[g]
...................................................................... Cnd R e
T PolA 0 SUM e
Ll L..l...........[.%7 |B CARRY N
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Full adder

— We can build full adder by using of half

adders or by many others way...

— Create the new schematic file “full_adder”,

and create symbol files

A SUM

B CARRY

0

R O R O R O L O

CIN IMPUT

...................................................... VoG D e+
s ry ihalf_adder

,.; ............................... | ................. : 'E';,T ......... e
T MEC E L iy SUM

‘B | |h_!_:'|'__.'T : :
v weC o ©....: |B CARRY

23 PV200, Week 02: Combination logic - Schematic, basic gates

P P P O P O O

A | B CIN | SUM | CARRY_
0 0 0



Full adder

— Put the half adder to the top schematic
— Compile it, program it, and test it...

KE v [2]
KE™" [0]
KEY[1]
MNode Name Direction
- KEY[2] | Input
®- KEY[1] Input
®- KEY[0] Input
‘@ LED[1] Output
‘@ LED[0] Output

Location

PIN_W15
PIN_AA1S
PIN_AA14
PIN_W16
PIN V16

I/ Bank

24 PV200, Week 02: Combination logic - Schematic, basic gates

| L — 2L epig)
... |CIN SUM | . o
CARRY L
T e — o

VREF Group Fitter Location I/ standard Reserved
B36_MNO PIN_W15 3.3-V LVCMO5
B3B_NO PIN_AATS 3.3-V LVCMOS
B3B8 MO PIN_AATS 3.3-V LVCMOS
B4A MO PIN_W1& 3.3-V LVCMOS5
BaA MO PIN_ V16 3.3-V LVCMOS

Current Strength

ZmA (default)
2maA (default)
2maA (default)
ZmaA (default)
2mA (default)

Slew Rate

M=
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Adding of two bits number

— Modify the top schema and test it

Mode Name

B KEY[3]
B KEY[2]
B KEY[1]
- KEY[O]
‘& LED[Z]
‘& LED[1]

= CUTEIT
A SUM T . -
B CARRY il
T Lo instE o
o, | i full_adder D
Efq.é...............; . . . . H -ﬁl-i.-i-.f:i;l“-ll- .......................................
; - I : > LED[1]
NPT : H :
i E>C _____ B apg. | CIN SUM |1 L
el P Bﬁ] 1‘51 (:.l'.:|'I.RRl"I"I ..................
i e B | i
s ;N: A et TR i [2]
\"IIEE CL L B e L R TR
Direction Location I/ Bank VREF Group Fitter Location IfO Standard Reserved Current Strength
Input PIN_Y16 3B B3B_NO PIN_Y16 3.3-V LVCMOS 2ma (default)
Input PIN_W15 3B B3E_NO PIN_W15 3.3-V LVCMOS 2maA (default)
Input PIN_AA1S 3B B3E_NO PIN_AA1S 3.3-V LVCMOS 2maA (default)
Input PIM_AATA 3B B3B_MNO PIM_AATS 3.3-V LVCMOS 2maA (default)
Cutput PIN_V17 48 B4A MO PIN_V17 3.3-V LVCMOS 2maA (default)
Cutput PIN_W16 44 B4A MO PIN_W16 3.3-V LVCMOS 2rmA (default)
Cutput PIN_V16 44 B4A MO PIN_V16 3.3-V LVCMOS 2maA (default)

‘= LED[0]
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Thank you for attention

Ing. Jifi Culen
liri.culen@mail.muni.cz
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